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Getting Started
Reporting Software



Diese Anleitung ist eine Kurzanleitung.
Ausführliche Informationen entnehmen Sie bitte der Betriebsanlei-
tung.
Die komplette Produktdokumentation besteht aus:
• Der vorliegenden Kurzanleitung
• Der in die Software integrierten Betriebsanleitung

These instructions are Brief Operating Instructions.
For detailed information, please read the Operating Instructions.
The complete product documentation comprises:
• These Brief Operating Instructions
• The Operating Instructions integrated in the software

<
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1 Auswertesoftware

1.1 Versionen
Die nachfolgende Tabelle zeigt die Funktionen der verschiedenen Soft-
wareversionen.

Funktion Essential 
Version (Free-

ware)

Professional 
Demoversion 

(nur 90 Tage gül-
tig)

Professional 
Version

Unterstützte Datenbanken:

Postgre SQL TM x x x

Oracle TM x x

Microsoft SQL Server TM x x

Unterstütze Geräte:

Paperless Recorder x x

Advanced Paperless Recorder x x

Digital Counter x x

Multi Channel Recorder x x x

Universal Data Manager x x x

Visual Data Manager x x

Safety Data Manager x x

Graphic Data Manager x x x

Advanced Data Manager x x x

Custody Transfer BTU Meter x x

Steam Calculator x x

Batch Controller x x

Sampler x x

Unterstütze Funktionen:

Benutzerverwaltung; LDAP Funk-
tion

x x
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Ein Wechsel von der Essential-Version und der Demoversion auf die Pro-
fessional-Version ist jederzeit durch Eingabe eines gültigen Lizenzschlüs-
sels möglich. Der Lizenzschlüssel kann im Dialogfenster "Lizenz 
ändern/aktivieren" unter dem Hauptmenü "Hilfe" eingegeben werden.
In diesem Menü kann über den Button "Versions-Information" auch jeder-
zeit die Übersicht mit den Unterschieden zwischen den einzelnen Versio-
nen aufgerufen werden.

Beachten Sie, dass die Demoversion nach Ablauf der 90 Tage automa-
tisch in eine Essential-Version umgewandelt wird, sofern kein Upgrade 
zur Professional-Version durch Eingabe eines Lizenzschlüssels erfolgt. 
Da bestimmte Funktionen dann nicht mehr zur Verfügung stehen, werden 
z.B. angelegte Templates (Vorlagen) mit Daten von mehreren Geräten 
und auch automatische Exporte nicht mehr funktionieren.
Geräte, die nur in der Professional-Version enthalten sind, können da-
nach nicht mehr ausgelesen werden.

Zugriffe von verschiedenen PCs 
auf die Datenbank gleichzeitig 
möglich

x x

Daten mehrerer Geräte in einem 
Template (Vorlage)

x x

Automatisches Auslesen x x x

Automatisches Löschen x x x

Automatischer Binär-Export x x x

Automatischer XLS/CSV- und 
PDF-Export

x x

Export ready for Energy Software x x

Import von Daten der Bedien- und 
Auslesesoftware

x x x

Online Visualisierung von 
Momentanwerten ("Live Data")

x x

Funktion Essential 
Version (Free-

ware)

Professional 
Demoversion 

(nur 90 Tage gül-
tig)

Professional 
Version
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1.2 Eigenschaften
Die Auswertesoftware ist eine Software, die eine zentrale Datenverwal-
tung mit Visualisierung für aufgenommene Daten bietet.

Diese ermöglicht die lückenlose Archivierung der Daten einer Messstelle, 
z.B.:
• Messwerte
• Diagnoseereignisse
• Protokolle

Die Auswertesoftware speichert Daten in eine SQL Datenbank. Die Da-
tenbank kann lokal oder im Netzwerk betrieben werden (Client / Server). 

Folgende Datenbanken werden unterstützt:
• PostgreSQL1) Version 9.2 bis einschließlich Version 11 (bei Essential-,

Demo- und Professional Version):
Sie können die auf der CD mitgelieferte, freie PostgreSQL Datenbank 
installieren und nutzen. Hierzu ist keine manuelle Installation und Kon-
figuration notwendig. Die Datenbank wird bei der Installation automa-
tisch konfiguriert.

• Oracle1) (bei Demo- und Professional Version): Version 8i bis ein-
schließlich Version 12c.
Zur Einrichtung der Software mit der Oracle Datenbank wenden Sie 
sich bitte an Ihren Datenbankadministrator.

• Microsoft SQL Server1) (bei Demo- und Professional Version): Version
2005 bis einschließlich Version 2019.
Zur Einrichtung der Software mit dem Microsoft SQL Server wenden Sie 
sich bitte an Ihren Datenbankadministrator.

1) Die genannten Produktnamen sind eingetragene Marken der jeweiligen Hersteller.
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1.3 Systemanforderungen
Für die Installation und den Betrieb der PC-Software müssen folgende 
Hardware- und Software- Voraussetzungen erfüllt sein:

Hardware:
• PC mit PentiumTM 4 (≥2 GHz)
• PC mit PentiumTM M (≥1 GHz)
• PC mit AMDTM (≥1,6 GHz)
• Minimum 1 GB RAM Cache 
• Minimum 20 GB freier Festplattenspeicher 
• Bildschirmauflösung mindestens 1024 x 800 Pixel 
• CD/DVD-Laufwerk

Betriebssystem/Software für die Auswertesoftware:
• MicrosoftTM WindowsTM Server 2003 R2 SP2 Standard, Enterprise
• MicrosoftTM WindowsTM Server 2008, 2012, 2016, 2019
• MicrosoftTM XP SP3
• MicrosoftTM VistaTM

• Windows 7TM

• Windows 8TM, Windows 8.1TM

• Windows 10TM

• WindowsTM .NET 2.0 SP1
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2 Installation
Der Installationsassistent führt durch die Installation der Auswertesoft-
ware.

Für die Installation werden Administratorrechte benötigt. 

2.1 Installation der Software
1. Legen Sie die CD in Ihr CD/DVD-Laufwerk.

Die Installation startet automatisch. 
Falls der Autostart nicht aktiv ist, starten Sie Setup.exe von der CD.

2. Wählen Sie im angezeigten Dialogfenster die gewünschte Sprache.
Klicken Sie auf OK.

3. Starten Sie anschließend den Installationsassistent mit Weiter.
4. Die Lizenzvereinbarung erscheint.

– Lesen Sie die Lizenzvereinbarung.
– Falls Sie die Vereinbarung nicht akzeptieren klicken Sie auf Ab-

brechen. 
– Falls Sie die Vereinbarung akzeptieren klicken Sie auf Weiter.

5. Geben Sie im nun angezeigten Dialogfenster den Benutzernamen 
und den Firmennamen ein. 

Klicken Sie auf Weiter.
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6. Wenn Sie die Professional-Version haben, geben Sie hier die Seri-
ennummer und den Lizenzschlüssel ein. Sie finden beide Angaben 
auf der CD-Hülle.
Falls Sie die Essential-Version haben oder die Angaben zu einem 
späteren Zeitpunkt eingeben möchten, lassen Sie die Eingabefelder 
leer. Es erscheint dann ein Dialogfenster mit dem Hinweis, dass die 
Essential-Version installiert wird.
Später können Sie den Lizenzschlüssel über den Menüpunkt "Hilfe 
-> Lizenz ändern/aktivieren" eingeben. Hier können Sie auch von 
der Essential-Version ohne Eingabe eines Lizenzschlüssels einma-
lig auf eine Demoversion mit vollem Funktionsumfang wechseln. 
Diese Demoversion ist dann für 90 Tage aktiv.

Die Demoversion wird nach Ablauf der 90 Tage in eine Essen-
tial-Version umgewandelt, sofern kein Upgrade zur Professio-
nal-Version durch Eingabe eines Lizenzschlüssels erfolgt.

Da bestimmte Funktionen dann nicht mehr zur Verfügung stehen, 
werden z. B. angelegte Templates mit Daten von mehreren Geräten 
und auch automatische Exporte nicht mehr funktionieren.

Klicken Sie auf Weiter.
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7. Geben Sie das Zielverzeichnis an, in welches die Auswertesoftware 
installiert werden soll.

Es wird ein Standardverzeichnis für die Installation vorgeschlagen.
Falls Sie das Programm in ein anderes Verzeichnis installieren 
möchten, klicken Sie auf Ändern und wählen Sie das gewünschte 
Verzeichnis.
Klicken Sie auf Weiter.

8. Wählen Sie aus, ob die mitgelieferte freie PostgreSQL Datenbank in-
stalliert werden soll. Die Datenbank wird bei der Installation automa-
tisch konfiguriert.

9. Wählen Sie aus, ob die Softwarekomponenten für Automatische Ak-
tionen installiert werden sollen.
Bestätigen Sie die Installation der Automatik-Komponente, so wird 
zusätzlich ein Windows Systemdienst eingerichtet. Dieser System-
dienst ermöglicht es, automatische Aktionen durch die Auswertesoft-
ware auszulösen und zu steuern - wie z.B. automatisches Auslesen 
von Geräten, automatischer Druck von Reports, automatisches Ge-
nerieren von Reports.
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Klicken Sie auf Weiter.

10. Der Installationsassistent ist nun zur Installation bereit.

Zur Korrektur Ihrer Angaben klicken Sie auf Zurück. Klicken Sie auf 
Installieren, um die Installation zu starten. 
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Klicken Sie auf Fertig stellen, um die Installation zu beenden. 

2.2 Verwendung mit einer OracleTM-Datenbank 
Nur bei Demo- und Professional-Version.
Wenden Sie sich für die Konfiguration der Oracle Datenbank an Ih-
ren Datenbankadministrator. Die folgenden Schritte können nur vom 
Administrator der Datenbank durchgeführt werden.

1. Installieren Sie die Software wie im Abschnitt "Installation" beschrie-
ben.

2. Legen Sie auf der Oracle Datenbank einen User an, unter dem sich 
die Software auf der Datenbank einloggen und zugreifen kann.
Der Benutzer muss über folgende Berechtigungen verfügen:
Roles:
– Connect
– Resource
Direct Granted System Privileges
– Create Table
– Create Procedure
– Create Sequence
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Nach dem Anlegen der Schemas (Schritt 3) sind die Rechte 
Create Table, Create Procedure und Create Sequence nicht 
mehr notwendig.

3. Starten Sie zum Einrichten der notwendigen Tabellen in der Daten-
bank die mitgelieferte Software "InitOracle.exe". Die Software befin-
det sich im Installationsverzeichnis.

4. Überprüfen Sie den Hostnamen/ IP-Adresse und Portnummer zum 
Datenbankserver und korrigieren Sie dies entsprechend.

5. Tragen Sie den eindeutigen System Identifier der Datenbank ein 
(siehe TNSNAMES.ORA).
Zuvor müssen Sie entsprechend einen Benutzer im Datenbank-Ser-
ver anlegen.

6. Geben Sie den Benutzernamen und das Passwort für den Benutzer 
ein, den die Auswertesoftware für das Login auf die Datenbank ver-
wenden soll. Benutzen sie hierzu "Benutzerdefiniertes Login"



Installation Reporting Software

14

7. Betätigen Sie die Schaltfläche "Test". Nach kurzer Zeit erscheint 
eine Meldung ob die Software auf die Datenbank zugreifen kann 
oder nicht. Ist der Zugriff nicht möglich, prüfen Sie bitte die Verbin-
dungseinstellungen und die Schreibweise des Benutzernamens und 
des Passworts. Erst wenn nach Betätigen der Schaltfläche "Test" 
eine positive Rückmeldung kommt, kann auf die Datenbank zugegrif-
fen werden. 

8. Wenn der Zugriff auf die Datenbank möglich ist, betätigen Sie die 
Schaltfläche "Erzeuge Schema". Jetzt werden die notwendigen Ta-
bellen für das Speichern der Daten in der Datenbank eingerichtet. 
Dies dauert einige Sekunden. Das Fenster der Software wird auto-
matisch geschlossen, wenn die Tabellen angelegt sind. 

9. Starten Sie die Auswertesoftware.

10. Im Menüpunkt "Extras -> Einstellungen -> Datenbank:" Wählen Sie 
"Oracle" aus und tragen Sie die Verbindung zur Datenbank, den Be-
nutzernamen und das Passwort ein.
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11. Prüfen Sie mit der Schaltfläche "Test", ob die Auswertesoftware auf 
die Datenbank zugreifen kann und die notwendigen Tabellen einge-
richtet sind. Ist der Zugriff nicht möglich, prüfen Sie die Verbindungs-
einstellungen und die Schreibweise des Benutzernamens und des 
Passworts. Erst wenn nach Betätigen der Schaltfläche "Test" eine 
positive Rückmeldung kommt, kann auf die Datenbank zugegriffen 
werden.

12. Wenn eine positive Meldung kommt, beenden Sie die Konfiguration 
mit OK. Die Auswertesoftware ist jetzt für den Betrieb mit der 
Oracle-Datenbank fertig eingerichtet.

2.3 Verwendung mit einer Microsoft SQL Server Da-
tenbank

Nur bei Demo- und Professional-Version.
Wenden Sie sich für die Konfiguration der Microsoft SQL Server Da-
tenbank an Ihren Datenbankadministrator. Die folgenden Schritte 
können nur vom Administrator der Datenbank durchgeführt werden.

1. Installieren Sie die Auswertesoftware wie im Abschnitt "Installation" 
beschrieben.

2. Legen Sie auf der Microsoft SQL Server Datenbank einen User an, 
unter dem sich die Auswertesoftware auf der Datenbank einloggen 
und zugreifen kann.
Der Benutzer muss zum Anlegen der Tabellen über die Berechtigung 
"db_ddladmin" verfügen:
Für den späteren Zugriff auf die Datenbank muss der Benutzer min-
destens die Rollen "db_datareader" und "db_datawriter" haben.
Zudem muss der Benutzer die EXECUTE-Berechtigung auf der Da-
tenbank haben.

3. Starten Sie zum Einrichten der notwendigen Tabellen in der Daten-
bank die mitgelieferte Software "InitSqlServer.exe". Die Software be-
findet sich im Installationsverzeichnis.
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4. Geben Sie die Verbindung zur Datenbank ein (Servername \ Instanz-
name). Der Servername ist der Hostname des Rechners, auf dem 
der Datenbankserver läuft. Der Instanzname kann bei der Installation 
angegeben werden und lautet für die SQL Express Installation stan-
dardmäßig "SQLEXPRESS". Sie können die installierten Instanzna-
men auch aus der Registrierung erfahren 
(HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\<Instance Name>). 

5. Tragen Sie den Datenbanknamen ein, den Sie zuvor am Server an-
gelegt haben (z.B. mit Hilfe des ‚Microsoft SQL Server Management 
Studio’ Tools).

6. Geben Sie den Benutzernamen und das Passwort für den Benutzer 
ein, den die Auswertesoftware für das Login auf die Datenbank ver-
wenden soll. Benutzen sie hierzu "Benutzerdefiniertes Login"
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7. Betätigen Sie die Schaltfläche "Test". Nach kurzer Zeit erscheint 
eine Meldung ob die Software auf die Datenbank zugreifen kann 
oder nicht. Ist der Zugriff nicht möglich prüfen Sie bitte die Verbin-
dungseinstellungen und die Schreibweise des Benutzernamens und 
des Passworts. Erst wenn nach Betätigen der Schaltfläche "Test" 
eine positive Rückmeldung kommt kann auf die Datenbank zugegrif-
fen werden. 

8. Wenn der Zugriff auf die Datenbank möglich ist, betätigen Sie die 
Schaltfläche "Erzeuge Schema". Jetzt werden die notwendigen Ta-
bellen für das Speichern der Daten in der Datenbank eingerichtet. 
Dies dauert einige Sekunden. Das Fenster der Software wird auto-
matisch geschlossen, wenn die Tabellen angelegt sind. 

9. Starten Sie die Auswertesoftware.

10. Im Menüpunkt "Extras -> Einstellungen -> Datenbank:" Wählen Sie 
"Microsoft SQL Server" aus und tragen Sie die Verbindung zur Da-
tenbank, den Benutzernamen und das Passwort ein.
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11. Prüfen Sie mit der Schaltfläche "Test" ob die Auswertesoftware auf 
die Datenbank zugreifen kann und die notwendigen Tabellen einge-
richtet sind. Ist der Zugriff nicht möglich, prüfen Sie die Verbindungs-
einstellungen und die Schreibweise des Benutzernamens und des 
Passworts. Erst wenn nach Betätigen der Schaltfläche "Test" eine 
positive Rückmeldung kommt, kann auf die Datenbank zugegriffen 
werden.

12. Wenn eine positive Meldung kommt, beenden Sie die Konfiguration 
mit OK. Die Auswertesoftware ist jetzt für den Betrieb mit der 
Microsoft SQL Server Datenbank fertig eingerichtet.

2.4 Remoteverbindungen auf den Datenbankserver 

2.4.1 Remoteverbindungen für PostgreSQL Server ermöglichen
Zuerst müssen Sie das Datenbank-Administrationstool "pgAdmin III" ins-
tallieren, das sich auf der Setup CD befindet.
1. Starten Sie das pgAdmin-Tool.
2. Öffnen Sie "Werkzeuge -> Serverkonfiguration -> postgresql.conf".
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3. Öffnen Sie die Einstellung "listen_addresses" mit einem Doppelklick 
und tragen Sie einen Stern (*) ein. Damit erlauben Sie alle eingehen-
den TCP Verbindungen zu diesem Server. Sie können aber auch 
einzelne IP-Adressen zulassen.

4. Standardmäßig werden alle Verbindungen von entfernten Adressen 
abgewiesen. Um diese zu erlauben, öffnen Sie "Werkzeuge -> 
Serverkonfiguration -> pg_hba.conf" und fügen Sie folgenden Ein-
trag hinzu:
host all all 0.0.0.0/0 md5
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5. Starten Sie den PostgreSQL durch einen PC-Neustart.
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Beachten Sie folgende Hinweise:
• Sie können die Konfiguration der Zugriffsrechte auch direkt in den Da-

teien "postgresql.conf" und "pg_hba.conf" vornehmen, die Sie im Instal-
lationsverzeichnis des PostgreSQL Server und "data" finden.

• Überprüfen Sie die Änderungen sorgfältig. Falsche Konfigurationen 
können dazu führen, dass der Zugriff auf den Server nicht mehr möglich 
ist (Bsp. Falsche IP-Adresse).

Weiterführende Informationen (Englisch) finden Sie unter:
http://www.postgresql.org/docs/9.2/interactive/client-authentication.html 

2.4.2 Remoteverbindungen für Oracle Server ermöglichen
Im Unterschied zu PostgreSQL und Microsoft SQL Server sind für den 
Oracle Server alle Zugriffe von einem bestehenden, entfernten Oracle Cli-
ent standardmäßig erlaubt.

2.4.3 Remoteverbindungen für Microsoft SQL Server ermöglichen
Sie müssen Remoteverbindungen für jede Instanz von SQL-Server er-
möglichen, zu der Sie eine Verbindung von einem Remote-Computer her-
stellen möchten. Gehen Sie hierzu folgendermaßen vor:
1. Start -> Programme -> Microsoft SQL Server 2005 -> Konfigurati-

onstools -> SQL Server-Oberflächenkonfiguration.
Das Fenster "SQL Server 2005-Oberflächenkonfiguration" erscheint.

2. Wählen Sie "Oberflächenkonfiguration für Dienste und Verbindun-
gen".

3. Öffnen Sie in "Database Engine" die "Remoteverbindungen".
Aktivieren Sie "Lokale Verbindungen und Remoteverbindungen" und 
das gewünschte Protokoll. Klicken Sie auf Anwenden.
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4. Folgende Meldung erscheint:
"Änderungen der Verbindungseinstellungen werden erst nach einem 
Neustart des Datenbankmoduldienstes wirksam."
Klicken Sie auf OK.

5. Öffnen Sie in "Database Engine" den Menüpunkt "Dienst".
Klicken Sie auf "Beenden" und warten Sie, bis der Dienst 
"MSSQLSERVER" beendet wird.
Klicken Sie auf "Start", um den Dienst "MSSQLSERVER" neu zu 
starten.

Überprüfen Sie die Änderungen sorgfältig. Falsche Konfigurationen 
können dazu führen, dass der Zugriff auf den Server nicht mehr mög-
lich ist (Bsp. Falsche IP-Adresse).

Weiterführende Informationen finden Sie unter:
http://support.microsoft.com/kb/914277
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2.5 Erweiterungen SQL Server und Automatik
Bei Verwendung der Windows Authentifikation sind zusätzliche Konfigu-
rationen notwendig:

1. Starten Sie "SQL Server Management Studio". Sollte diese kosten-
lose Software nicht vorhanden sein, müssen Sie diese, entspre-
chend Ihrer SQL Server Version nachinstallieren. Erhältlich ist das 
Programm bei Microsoft.

2. Selektieren Sie den Knoten "Anmeldung" unter dem Verzeichnis "Si-
cherheit".

3. Legen Sie über die rechte Maustaste auf diesem Verzeichnis eine 
neue Anmeldung mit dem Namen 
NT-AUTORITÄT\ANONYMOUS-ANMELDUNG an oder englisch 
NT-AUTHORITY\ANONYMOUS.

4. Selektieren Sie die Datenbank der Auswertesoftware unter dem "Da-
tenbanken" Knoten.

5. Legen Sie dort unter "Sicherheit/Benutzer" einen neuen Benutzer mit 
dem Anmeldenamen 
NT-AUTORITÄT\ANONYMOUS-ANMELDUNG an.

6. Abschließend weisen Sie diesem Benutzer unter "Mitgliedschaft in 
Datenbankrollen" Besitzerrechte zu (db-owner).



Installation Reporting Software

24

2.6 Update der Software
Bei der Verwendung des mitgelieferten Postgre DB Server lokal auf Ihrem 
PC wird bei der Installation der neueren Version die Datenbank bei Bedarf 
automatisch auf die neue Version gebracht. In diesem Fall (Standardfall) 
müssen Sie nach der Installation der neuen Version keine weiteren Akti-
onen durchführen. Alle Daten stehen nach dem Update wieder zur Verfü-
gung.
Verwenden Sie den mitgelieferten Postgre DB Server im Netzwerk (remo-
te) oder eine Oracle oder Microsoft SQL Server Datenbank (lokal oder im 
Netzwerk), kann nach dem ersten Start der Auswertesoftware der DB 
Konfigurationsdialog mit einem Hinweis erscheinen, dass die Datenbank 
nicht auf dem aktuellen Stand ist.
In diesem Fall muss der Administrator der Datenbank wie oben beschrie-
ben das jeweilige Tool für Ihren Datenbankserver z.B. Init_Oracle starten 
und damit die Daten der Datenbank auf den aktuellen Stand bringen. Die 
Daten in der Datenbank bleiben dabei erhalten. Bitte beachten Sie, dass 
alle Client Installationen auf die neue Version der Auswertesoftware up-
gedatet werden.
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3 Schnelleinstieg
Dieser Schnelleinstieg gibt einen kurzen Überblick über die ersten Schrit-
te beim Arbeiten mit der Auswertesoftware. Detaillierte Informationen und 
Hilfe zu den Funktionen finden Sie in der Online-Hilfe.

3.1 Bedienoberfläche
Die Bedienoberfläche ist in drei Bereiche aufgeteilt:
• Oben befindet sich die Menüleiste mit Funktionsgruppen für Soft-

wareeinstellungen.
Datei -> Programm beenden
Ansicht -> Einstellungen zur Ansicht
Extras -> Einstellungen zur Datenbank, Sprache, Benutzerverwaltung, 
Audit Trail 
Hilfe -> Online-Hilfe starten, Software Information, Lizenz ändern/akti-
vieren

• Links befindet sich die Aufgabenleiste. Durch Klicken auf eine Aufgabe 
öffnet sich diese. Die enthaltenen Funktionen werden angezeigt: 
Visualisierung -> Visualisierungstemplate neu erstellen, öffnen oder lö-
schen
Daten auslesen -> Auslesen über Speicherkarte oder online-Verbin-
dung zum Gerät
Datenverwaltung -> Anlagenansicht, Export und Import von Geräteda-
ten

• Rechts befindet sich der Arbeitsbereich
Alle aktiven Aufgaben werden hier geöffnet. Sind mehrere Aufgaben ak-
tiv, so werden diese in Tabs hintereinander geöffnet.
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3.2 Bedienung
Bei allen gewählten Funktionen führt ein Assistent durch die benötigten 
Angaben. Zur Korrektur Ihrer Angaben können Sie jederzeit auf Zurück 
klicken oder den Assistenten beenden durch Abbrechen. 
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4 Erste Schritte

4.1 Daten auslesen von einer Speicherkarte
Klicken Sie auf "Daten auslesen -> Speicherkarte" und wählen Sie das 
gewünschte Verzeichnis, in dem die Daten gespeichert sind.

Klicken Sie auf Weiter.
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Es werden die Daten geöffnet und die Geräte angezeigt, von welchen Da-
ten enthalten sind. Selektieren Sie die gewünschten Geräte und den ge-
wünschten Zeitraum und klicken Sie auf Weiter. 
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Die Daten werden eingelesen. Die Dauer des Einlesevorganges ist ab-
hängig von der Datenmenge. Beenden Sie den Assistenten mit 
Schließen.

4.2 Visualisierung
Zur Visualisierung der Daten aus der Datenbank wird ein Template benö-
tigt, das die Auswahl der Daten und die Art ihrer Darstellung beschreibt. 
Sie können ein gespeichertes Template Öffnen oder durch Neu ein neu-
es erstellen. Durch Template löschen kann ein Template gelöscht wer-
den.

Beachten Sie folgende Hinweise:
• Es wird nur das Template zur Visualisierung gelöscht, nicht die gespei-

cherten Daten. 
• Mit der Essential-Version können keine Vorlagen mit mehr als einem 

Gerät angelegt, angezeigt oder editiert werden.
• Mit der Essential-Version können keine Vorlagen mit einem Gerät an-

gelegt, angezeigt oder editiert werden, wenn das Gerät nicht von der 
Essential-Version unterstützt wird.

Klicken Sie auf "Visualisierung -> Neu". 
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Die Geräte, von denen Daten vorhanden sind, werden in der Anlagenan-
sicht angezeigt.

Wählen Sie die gewünschten Geräte durch Doppelklick oder -> aus und 
klicken Sie auf Weiter.
Falls das Gerät mehrere Kanäle besitzt, können im nächsten Schritt die 
gewünschten Kanäle markiert werden.
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Klicken Sie auf Weiter. 
Wählen Sie den gewünschten Zeitraum der Visualisierung aus.

Klicken Sie auf Weiter. 
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Die Visualisierung der Daten wird nun in mehreren Bereichen angezeigt. 
Jeder einzelne Bereich kann minimiert werden. 
Oben ist die Darstellung der Kurve zu sehen. Der Verlauf der ausgewähl-
ten Messwerte über die Zeit wird dargestellt. In dem Graf sind außerdem 
Ereignisse eingetragen, die zu bestimmten Zeitpunkten auftraten. 
Darunter sind die Messwerte tabellarisch aufgeführt. 
Darunter sind die Ereignisse aufgeführt. Durch Klicken auf ein Ereignis in 
der Ereignisliste wird dieses in der Kurvendarstellung markiert.

Bei ausgewählten Messwerten eines Probenehmers wird in einem weite-
ren Bereich das Programmlogbuch angezeigt. Es enthält alle im ausge-
wählten Zeitraum vollständig abgelaufenen Probenahme-Programme. 
Neben der Bereichsüberschrift "Programmlogbuch" gibt es eine "Doku-
ment"-Schaltfläche. Nach Selektieren eines Probenahme-Programms 
kann dieses über die "Dokument" -Schaltfläche geöffnet und danach ge-
speichert und ausgedruckt werden.
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5 Reporting Software

5.1 Versions
The following table shows the different functions of the diverse versions of 
the Reporting Software.

Function Essential 
Version 

(Freeware)

Professional trial 
version 

(restricted on 90 
days)

Professional 
Version

Supported databases:

Postgre SQL TM x x x

Oracle TM x x

Microsoft SQL Server TM x x

Supported devices:

Paperless Recorder x x

Advanced Paperless Recorder x x

Digital Counter x x

Multi Channel Recorder x x x

Universal Data Manager x x x

Visual Data Manager x x

Safety Data Manager x x

Graphic Data Manager x x x

Advanced Data Manager x x x

Custody Transfer BTU Meter x x

Steam Calculator x x

Batch Controller x x

Sampler x x

Supported functions:

User administration; LDAP 
function

x x
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A change from the Essential version and the trial version to the 
Professional version is possible at any time by entering a valid license 
key. The license key can be entered in the dialog box "Change/activate 
license" under the main menu "Help".
In the same menu the overview on the differences between the various 
software versions can be seen at any time ("License information").
Please note that the trial version is automatically turned into an Essential 
version after the 90 days have elapsed unless an upgrade by entering a 
license key is done. Since certain functions then will no longer be 
available, for example created templates with data of more than one 
device and also automatic exports will no longer work.

Several accesses to the database 
from various PCs at the same 
time possible

x x

Data of more than one device 
inside a template

x x

Automatic readout x x x

Automatic deletion x x x

Automatic binary export x x x

Automatic XLS/CSV and PDF 
export

x x

Export ready for Energy Software x x

Import of data from the operation 
and read out software

x x x

Online visualization of current 
measured values ("Live Data")

x x

Function Essential 
Version 

(Freeware)

Professional trial 
version 

(restricted on 90 
days)

Professional 
Version
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5.2 Features
Reporting Software is a software package offering central data 
management and visualization of stored data. This allows complete 
documentation of the data from a measuring point, e.g.:
• measurement values
• diagnostics events
• protocols

The Reporting Software stores the data in a SQL database. The data base 
can be installed locally or in a network (Client/Server).

Following data bases are supported:
• PostgreSQL1) version 9.2 up to version 11 (for the Essential, Demo

and Professional versions):
You can use the PostgreSQL database provided on the Reporting 
Software CD. During installation the database will be automatically 
configured. That means there is no need for manual installation and 
configuration.

• Oracle2) (for the Demo and Professional version):
Version 8i up to version 12c.
For the login account please contact your database administrator.

• Microsoft SQL Server1) (for the Demo and Professional version):
Version 2005 up to version 2019. For the login account please contact 
your database administrator.

2) The products referred to are trademarks of their respective companies.
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5.3 System requirements
For installation and use of the software, the following hardware and 
software requirements have to be fulfilled:

Hardware:
• PC with PentiumTM 4 (≥2 GHz)
• PC with PentiumTM M (≥1 GHz)
• PC with AMDTM (≥1.6 GHz)
• At least 1 GB RAM Cache
• At least 20 GB free harddisk space 
• Display resolution min. 1024 x 800 pixel 
• CD/DVD-ROM drive

Operating system/software for the reporting software:
• MicrosoftTM WindowsTM Server 2003 R2 SP2 Standard, Enterprise
• MicrosoftTM WindowsTM Server 2008, 2012, 2016, 2019
• MicrosoftTM XP SP3
• MicrosoftTM VistaTM

• Windows 7TM

• Windows 8TM, Windows 8.1TM

• Windows 10TM

• WindowsTM .NET 2.0 SP1
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6 Installation
The installation wizard guides you through the installation of the Reporting 
Software.

You need administrator rights for the installation. 

6.1 Installation of the software
1. Insert the CD in your CD/DVD-drive. The Installation starts 

automatically.
If autostart is not active, start Setup.exe directly from the CD.

2. In the dialog window select the language for the installation.
Click OK.

3. Start the installation wizard with Next.
4. The licensing agreement appears.

– Please read the license agreement carefully.
– Mark if you accept or not accept the licensing agreement.
– If you do not accept the licensing agreement click on Cancel. 
– If you do accept the licensing agreement click on Next

5. In the following dialog window enter the user name and company 
name.

Click on Next.
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6. If you use the Professional version enter the serial number and the 
license key of your Reporting Software. You can find the information 
on the CD cover of the software.
If you use the Essential version or you want to enter these 
informations later please leave the entry fields empty. A dialog box 
informs you, that a Essential version will be installed. 
You can enter the license key any time in the menu "Help -> Change 
License / Activate". Here also you can once-only switch to the Trial 
version. The Trial version runs for 3 month with full functionality.

After 90 days the Trial version converts automatically to an 
Essential version with limited functions if not upgraded.

Click on Next.

7. Enter the destination folder in which you want to install the Reporting 
Software.
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A default location will be displayed. If you want to install the software 
in a different folder click Change and choose the desired folder.
Change and choose the desired folder. 
Click on Next. 

8. Select if you want to install the free of charge PostgreSQL database. 
The database is configured automatically during the installation.

9. Select if you want to install software components for automatic 
actions.
If you select the installation, a Windows system service will be 
configured. This service enables Reporting Software to start 
automatic actions, e.g. automatic read out of device data, automatic 
printing of reports or automatic generation of reports. 
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Click on Next. 

10. The installation wizard is ready for the installation.

To review or change any of your installation settings click Back. 
Click Install to start the installation.
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The installation is completed
Click on Finish.

6.2 Operation of the software with OracleTM database 
Only at Trial and Professional version.
For the configuration of the database and the Reporting software 
please contact your database administrator. The following steps 
should only be done by the administrator of the database. 

1. Install the Reporting software. Please refer to the chapter 
"Installation".

2. Create a user in the oracle database which the Reporting Software 
may use for login and access to the database.
The user must have the following rights:
Roles:
– Connect
– Resource
Directly Granted System Privileges:
– Create Table
– Create Procedure
– Create Sequence
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The privileges Create Table, Create Procedure and Create 
Sequence are necessary to create the tables and schemas 
(step 3). Afterwards for the access to the database these 
privileges are not necessary. 

3. In the installation folder of the Reporting Software the program 
"InitOracle.exe" supports the creation of the tables and schemas on 
the Oracle database. After starting the program the following window 
appears:

4. Please set the correct host name / IP address and port number of the 
database server. 

5. Please set the unique system identifier of the database (see 
TNSNAMES.ORA). Please create the user for the database in 
advance.

6. Set user name and password which the Reporting Software will use 
for login on the database. Please use the "user custom login". 
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7. Click on the test button. After a few seconds a message will show 
whether the software is able to access the database or not. If the 
access is not possible please verify the settings of the connection and 
the spelling of user name and password. The software can only 
access the database when there is a positive message after clicking 
the "test" button.

8. After the access to the database is established, please click on the 
button "Create schema". The necessary tables for the storage of the 
data will be created in the database. After a few seconds, when all 
tables are created, the window is closed automatically. 

9. Launch the Reporting software.
10. In the menu "Extras -> Settings -> Database" select Oracle and 

configure the connection to the database. Enter the user name and 
password.

11. Click on the "test" button and check whether the software can connect 
to the database and whether the necessary tables are created. If the 
access to the database is not successful please verify the settings of 
the connection and the spelling of the user name and password. Only 
in case of a positive message the access to the database is possible. 

12. After a positive message please click on OK to close the 
configuration dialog. The Reporting Software in now configured to 
access the Oracle database.
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6.3 Operation of the software with Microsoft SQL 
Server database

Only at Trial and Professional version.
For the configuration of the database and the Reporting Software 
please contact your database administrator. The following steps 
should only be done by the administrator of the database. 

1. Install the Reporting Software. Please refer to the chapter 
"Installation".

2. Create a user in the Microsoft SQL server database which Reporting 
Software may use for login and access to the database.
For the creation of the tables the user must have the following right 
"db_ddladmin" in the database. Later after the initialization of the 
database the user must have at least the roles "db_datareader" and 
"db_datawriter" to access the database. The user must also have 
EXECUTE authorization on the database.

3. In the installation folder of the Reporting Software the program 
"InitSqlServer.exe" supports the creation of the tables and schemas 
on the Microsoft SQL server database. After starting the program the 
following window appears:
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4. Please configure the connection to the database (server 
name\instance). The server name is the hostname of the computer 
on which the database server is running. The instance can be set 
during the installation of the database server and is for SQL Express 
by default "SQLEXPRESS". You can see the installed name of the 
instance in the registration 
(HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\<Instance Name>).

5. Configure the name of the database, which you created in the 
database server before (i.e. with Microsoft SQL Server Management 
Studio’ tools). 

6. Set user name and password which the Reporting Software will use 
for login on the database. Please use the "user custom login". 

7. Click on the test button. After a few seconds a message will show 
whether the software is able to access the database or not. If the 
access is not possible please verify the settings of the connection 
and the spelling of user name and password. The software can only 
access the database when there is a positive message after clicking 
the test button.

8. After the access to the database is established, please click on the 
button "Create schema". The necessary tables for the storage of the 
data will be created in the database. After a few seconds, when all 
tables are created, the window is closed automatically. 

9. Launch the Reporting Software.

10. In the menu "Extras -> Settings -> Database" select Microsoft SQL 
Server and configure the connection to the database. Enter the user 
name and password.
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11. Click on the "test" button and check whether the Reporting Software 
can connect to the database and whether the necessary tables are 
created. If the access to the database is not successful please verify 
the settings of the connection and the spelling of the user name and 
password. Only in case of a positive message the access to the 
database is possible. 

12. After a positive message please click on OK to close the 
configuration dialog. The Reporting Software in now configured to 
access the Mircosoft SQL Server.
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6.4 Enable remote connections to the database 
server

6.4.1 Enable remote connection to PostgreSQL server
First install the database administration tool "pgAdmin III". The tool is 
located on the setup CD.
1. Start the "pgAdmin III" tool.
2. Open "Tools -> Server Configuration -> postgresql.conf".
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3. Open the settings "listen_addresses" with double click and enter an 
asterisk (*). This enables all incoming TCP connections to this 
server. It is also possible to accept individual IP addresses.

4. Per default all connections to remote addresses are rejected. To 
allow these, open "Tools -> Server Configuration -> pg_hba.conf" 
and add the following entry:
host all all 0.0.0.0/0 md5

5. Start "PostgreSQL" with PC new start.
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Pay attention to:
• The configurations which are described in the steps above can directly 

be done in the files "postgresql.conf" and "pg_hba.conf". These files are 
located in the installation folder of PostgreSQL Server under "data".

• Check the changes you made very carefully. Wrong settings can 
disable the access to the server (e.g. wrong IP address).

For further information see:
http://www.postgresql.org/docs/9.2/interactive/client-authentication.html 

6.4.2 Enable remote connection for Oracle server
For Oracle Server the access from a remote Oracle client is allowed per 
default in contrast to PostgreSQL and Microsoft SQL Server.

6.4.3 Enable remote connection for Microsoft SQL server
You have to enable remote connections to every instance of SQL server 
you want access to from a remote computer. Perform the following steps:
1. Start -> Programs -> Microsoft SQL Server 2005 -> Configuration 

tools -> SQL Server surface configuration.
The window "SQL Server 2005 Surface Area Configuration" opens.

2. Select "Surface configuration for services and connections".
3. In "Database Engine" open "Remote connections".

Activate "Local connections and remote connections" and the 
appropriate protocol. Click on Apply.
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4. The message opens:
"Changes of the connection settings become effective after a restart 
of the database module service."
Click on OK.

5. On "Database Engine" open "Services".
Click on Finish and wait until the service MSSQLSERVER 
terminates.
Click on Start, to restart the service MSSQLSERVER.

Check the changes you made very carefully. Wrong settings can 
disable the access to the server (e.g. wrong IP address).

For further information see:
http://support.microsoft.com/kb/914277
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6.5 Configuration of Microsoft SQL Server and 
automatic actions

When using Windows Authentication the additional configurations are 
necessary:

1. Start the "SQL Server Management Studio". If this software is not 
installed on your PC you can download the software from the website 
of Microsoft free of charge. Please take care that you download the 
software for your version of the SQL Server. Install the software on 
your PC.

2. Select the node "Login/Account" in the folder "Security".
3. Create with the right mouse click in this folder an additional account 

NT-AUTHORITY\ANONYMOUS.
4. Now select the database of the reporting software in the node 

"databases".
5. Please create in Security/User a new user with the name 

"FdmServiceUser" and the name NT_AUTHORITY\ANONYMOUS.
6. Finally assign to the user in "member of database roles" the rights 

db-owner.
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6.6 Update of the software to a new version
When the Reporting Software works with the delivered Postgre DB Server 
local on your computer, the database is updated to the new version if 
necessary automatically. In this case (standard case) it is not necessary 
that you do any additional steps after the installation. The data in the 
database remain available after the update.
When you use the delivered Postgre DB Server in the network (remote) or 
an Oracle or Microsoft SQL Server database (local or remote) it may be 
that after the first start of the Reporting Software the configuration dialog 
of the database connection comes up with a hint that the database is not 
updated to the current version.
In this case the administrator of the database has to run the corresponding 
tool for the database server i.e. Init_Oracle in order to update the 
database schema to the new version. The database administrator should 
follow the steps described above. After the update all data remain 
available in the database.

Make sure that all client PCs of the Reporting Software are updated 
to the new version.
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7 Getting started
This introduction provides a brief overview of the first steps using 
Reporting Software. You find detailed information and help to the 
functions in the online help of the Reporting Software. 

7.1 User interface
The user interface of the Reporting Software is divided into three areas
• At the top is the menu bar with function groups for the settings: 

File -> Program end 
View -> Settings of the display
Extras -> Settings of database, language, user administration, audit trail
Help -> Online help, software information, change license/activate

• On the left hand side is the task pane. By clicking on a task the 
contained functions are displayed:
Visualization -> Visualization template new, open or delete
Read out data -> read out data from a mass storage or online 
connection to the device
Data management -> open plant view, export or import of device data

• On the right hand side is the working area:
All active tasks are opened here. If multiple tasks are open, they are 
displayed in different tabs.
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7.2 Usage
With all functions a wizard guides you through the needed inputs. To 
correct you inputs click on Back. To abort the wizard click on Cancel. 
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8 First steps

8.1 Read out data of a mass storage device
Click on "Read out data -> Mass storage" and select the folder in which 
the data is stored.

Click on Next.
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The data will be opened and the contained devices are displayed. Select 
the required device and time period. 
Click on Next.

The data will be read out and stored in the database. The duration 
depends on the amount of data. Exit the wizard with Close. 
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8.2 Visualization
For viewing the data of the database, you need a template that describes 
the selected data and the settings for the visualization. You can open a 
saved template or create a new one. Click on Open or New. With Delete 
Template it can be deleted.

Pay attention to:
• Only the template for the visualization will be deleted, not the stored 

data. 
• The Essential version does not allow to create, to display or to edit 

templates with more than one device.
• The Essential version does not allow to create, to display or to edit 

templates for devices not supported by the Essential version.

Click Visualization -> New. 
The devices with available data are displayed in the plant view.

Select the required devices by double clicking or place the right arrow over 
it and click on Next
If the selected device has several channels you can select the channel in 
the next step.
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Click on Next.
Select the time period you want to display. 

Click on Next. 
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The visualization of the data is divided into several areas. Each area can 
be minimized by clicking the double-arrow on the right side of the area. 
At the top is the curve display. The measurement values are displayed 
over the time. In the graph, events are indicated at the time point when 
they occurred. 
Below all measurement values are listed in a table. 
At the bottom the events are listed in a table.
By clicking on an event or a measurement value in the tables, it will be 
indicated in the curve with an indicating line. 

With selected data of a sampler there is an additional area with the 
Program Logbook. It contains all completed sample programs of the 
selected time period. Beside the area header 'Program Logbook' is a 
"Document" button. After selection of a sample program it can be opened 
with the "Document" button and afterwards saved and printed. 
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